USER'S MANUAL
for the
NAVAL INTERACTIVE DATA ANALYSIS SYSTEM
(NIDAS) Version 1.0
Technical Note 03-94
29 November 1993

Prepared for: Naval Oceanographic Office (Code DOST)
Stennis Space Center, Mississippi 39529

Contract Number: NAS13-564, Order No. 11

Approved for public release; distribution is unlimited.
Mississippi State University Center for Air Sea Technology
Stennis Space Center, MS 39529-6000
SOFTWARE USER'S MANUAL

FOR THE
NAVAL INTERACTIVE DATA ANALYSIS SYSTEM
(NIDAS)

CONTRACT NO. NAS13-564 D.O. 11

NIDAS Version 1.0 (29 November 1993)

CONTRACT NO: NAS13-564 D.O. 11

Prepared for:

NAVAL OCEANOGRAPHIC OFFICE
CODE DOST
STENNIS SPACE CENTER, MS 39529

Prepared by:

Mississippi State University
Center for Air Sea Technology
Building 1103, Room 233
Stennis Space Center, MS 39529-6000

DATA QUALITY INSPECTED 1
Acknowledgements

UNIX is a trademark of American Telephone and Telegraph (AT&T), Incorporated
SUN, SUNOS and SparcStation are trademarks of Sun Microsystems, Incorporated
Motif is a trademark of the Open Software Foundation
X-Windows is a trademark of the Massachusetts Institute of Technology
Empress is a trademark of Empress Software, Incorporated
ag/X Toolmaster is a trademark of UNIRAS, Incorporated, a subsidiary of Advanced
Visual Systems (AVS), Incorporated

Contributors to the NIDAS Software User's Manual are:

Mr. Dharmesh Krishnamagaru, Software Engineer/Project Manager
Mr. Vishnu Mohan Das, Programmer
Mr. Micheal S. Foster, Editor
Ms. LeAna Dusang, Structure, Content and Graphical Artwork
# Table of Contents

<table>
<thead>
<tr>
<th>Section</th>
<th>Page Number</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cover Sheet</td>
<td>i</td>
</tr>
<tr>
<td>Acknowledgements</td>
<td>ii</td>
</tr>
<tr>
<td>Table of Contents</td>
<td>iii</td>
</tr>
<tr>
<td>List of Figures</td>
<td>v</td>
</tr>
</tbody>
</table>

1 SCOPE

1.1 Identification

1.2 Overview

1.2.1 Data Overview

1.2.2 Functionality Overview

1.2.3 Support Overview

1.3 Document Overview

1.3.1 References

1.3.2 Format and Content

1.3.3 Definitions and Conventions

2 REFERENCED DOCUMENTS

3 EXECUTION PROCEDURES

3.1 Initialization (Launching the Application)

3.2 Initialization (Configuration) Files

3.3 Description of Display Windows

3.3.1 Main Window (NIDAS Graphical User Interface)

3.3.1.1 Title

3.3.1.2 Main Chart

3.3.1.3 Profile Composite Chart

3.3.1.4 Menu Bar

3.3.1.4.1 The File Pulldown Menu

3.3.1.4.2 The Tools Pulldown Menu

3.3.1.4.3 The Help Pulldown Menu

3.3.1.5 Remark

3.3.1.6 Parameter vs. Depth

3.3.1.7 Repaint

3.3.2 Data Retrieval Module (DRM)

3.3.2.1 Data Selection - BATHY (Bathymetry)

3.3.2.2 Data Selection - MODAS

3.3.2.3 Data Selection - CLIMO (Climatology)

3.3.2.4 Data Selection - COAST (Coastline)

3.3.2.5 Data Selection - MOODS

3.3.2.6 Data Selection - GOODS

3.3.2.7 Data Selection - FRONTS

3.3.2.8 Data Selection - EDDIES

3.3.2.9 Data Selection - MODASPROF
3.3.2.10 Data Selection - CLIMOPROF .................................. 23
3.3.2.11 Data Selection - IMAGE .......................................... 23
3.3.2.12 Data Selection - NIDAS3D ....................................... 24
3.3.2.13 Data Selection - NIDASPROF ................................. 25
3.3.3 Data Interactive Module (DIM) .................................... 25
3.3.3.1 Data Editing - Polygon ............................................ 26
3.3.3.2 Data Editing - Zoom ................................................ 26
3.3.3.3 Data Editing - Transect ........................................... 27
3.3.3.4 Data Editing - Synthetic .......................................... 27
3.3.3.5 Data Editing - Single MODAS ................................. 30
3.3.4 NIDAS Session Module (NSM) ................................. 30
3.3.4.1 NSM Initiate - New ............................................... 31
3.3.4.2 NSM Initiate - Unclosed ......................................... 32
3.3.4.3 NSM Session Boundary Overlay - Display .................. 33
3.3.4.4 NSM Session Boundary Overlay - Data ...................... 33
3.3.4.5 NSM Session Boundary Overlay - Options .................. 33
3.3.4.6 NSM Repeat - Repeat ............................................. 34
3.3.4.7 NSM Terminate - Close ........................................... 34
3.3.4.8 NSM Terminate - Turnoff ...................................... 34

4 ERROR MESSAGES ................................................................ 35

5 NOTES ................................................................................. 36
5.1 Glossary ................................................................. 36
5.2 Abbreviations (acronyms) .......................................... 36
5.3 System Considerations .................................................. 36
  5.3.1 System/Software Requirements ............................... 36
  5.3.2 Directory Map .......................................................... 37
  5.3.3 Security ................................................................. 37
  5.3.4 Installation Procedures ............................................. 37

APPENDICES
A  Glossary of Terms .......................................................... A-1
B  List of Acronyms ............................................................ B-1
C  User Default File ............................................................ C-1
D  Commercial and Noncommercial Software ...................... D-1
E  NIDAS Installation Procedures ......................................... E-1
LIST OF FIGURES:

Figure 1. Top-level modular structure of the Navy Interactive Data Analysis System (NIDAS) ................................................... 3
Figure 2. NIDAS “Main Window” display screen ............................................................ 7
Figure 3. NIDAS “Main Window” menu headers and pulldown menu options .......... 9
Figure 4.a. The NIDAS “Axis Options” pop-up window for the “Main Chart” .............. 10
Figure 4.b. The NIDAS “Axis Options” pop-up window for the “Profile Composite Chart” .......................... 10
Figure 5. The NIDAS “Exit” pop-up window ......................................................... 11
Figure 6. The Tools “Data Selection Status” pop-up window .................................. 11
Figure 7.a. The Tools “Export: Data” pop-up window ........................................... 12
Figure 7.b. The Tools “Export Data” pop-up window ............................................. 12
Figure 7.c. The Tools “User Interactions” (“Export”) pop-up window .................. 13
Figure 8. Illustration of Data Retrieval Module (DRM) “Data Selection” window ... 14
Figure 9. The BATHY “Bathymetry Options” pop-up window .............................. 15
Figure 10. DRM “MODAS Data” pop-up window ................................................ 16
Figure 11. DRM “CLIMO Data” pop-up window for CLIMO (climatology) and CLIMOPROF (climatology profile) data types ........................................... 17
Figure 12. DRM “Coastline Data” pop-up window for the Coastline, Fronts, and Eddies data types. .......................... 17
Figure 13. DRM “Coastline Options” pop-up window for the Coastline and Climatology Profile data types ............................................................ 18
Figure 14. DRM Data Selection pop-up window for the MOODS data type ............ 19
Figure 15. DRM “Time Selection” pop-up window for setting MOODS date/time criteria ... 20
Figure 16. DRM “MOODS Options” pop-up window for the MOODS and GOODS data types. ............................................................ 21
Figure 17. DRM Data Selection pop-up window for the GOODS data type ............ 22
Figure 18. DRM “Fronts Data” pop-up window for the Fronts and Eddies data types .... 22
Figure 19. DRM “MODAS Profile Options” pop-up window for the MODAS Profile data type ............................................................ 23
Figure 20. DRM “Image Data” pop-up window for the Image data type ............... 24
Figure 21. DRM “3D Volume Data” pop-up window for the NIDAS3D data type .... 25
Figure 22. The DIM “Data Editing” control and option selection window .......... 26
Figure 23. The DIM zoom options pop-up window ................................................ 27
Figure 24. The DIM Transect pop-up window ........................................................ 27
Figure 25. The DIM “Synthetic Profile” pop-up window ......................................... 28
Figure 26. The DIM “Repeat Dialog” pop-up window ............................................. 29
Figure 27. The DIM “Editing Dialog” pop-up window ........................................... 29
Figure 28. Profile Saving Dialog pop-up window from the DIM “Last Polygon” Option .... 30
Figure 29. The NSM “Synthetic Admin Info” control window .............................. 31
Figure 30. The NSM “New Session” pop-up window ............................................. 32
Figure 31. The NSM “Unclosed Sessions” pop-up window (form also used for “Overlay Sessions” and “Repeat Sessions”) .......................... 33
Figure 32. The NSM “Color Overlay Options” pop-up window .............................. 33
NIDAS USER'S MANUAL

1 SCOPE

1.1 Identification

Computer Software Configuration Item (CSCI): Naval Interactive Data Analysis System (NIDAS)

Version: 1.0

Release Date: 29 November 1993

Contract No: NAS13-564 D.O. 11

Contractor: Mississippi State University
Center for Air Sea Technology
J. H. Corbin, Director
Building 1103, Room 233
Stennis Space Center, MS 39529-6000
Telephone: (601) 688-2561
Facsimile: (601) 688-7100

Project Manager: Mr. Dharmesh Krishnamaguru
Mississippi State University
Center for Air Sea Technology
Stennis Space Center, Mississippi 39529-6000
(MSU Proposal No. 93-3-467)

1.2 Overview

NIDAS provides interactive blending and overlay capabilities for a broad range of environmental data types and formats. The product output of NIDAS is a three-dimensional gridded field of temperature and salinity constructed from 1) data derived by the user internally within NIDAS by synthesis and 2) data obtained from external numerical models, observations and climatological databases.

1.2.1 Data Overview

NIDAS operates using numerous oceanographic data categories stored in an installed version of the Naval Environmental Operational Nowcast System (NEONS), a relational database management system (rdbms) which employs the EMPRESS proprietary rdbms engine. Data management, configuration, and control functions for the supporting rdbms are performed externally. NIDAS retrieves and stores data to/from the rdbms but exercises no direct internal control over the rdbms or its configuration. Data is also ingested into the rdbms, for use by NIDAS, by external data acquisition processes. The data categories employed by NIDAS are as follows:

- Bathymetry - ocean depth at five minute resolutions
- MODAS - gridded fields of temperature, salinity and sound speed produced by the Modular Ocean Data Assimilation System (MODAS)
Climatology - gridded fields of temperature, salinity and sound speed provided by NAVOCEANO

Coastline - vector coordinates of the shoreline at several different resolutions from the World Vector Shoreline (WVS) datasets

MOODS - oceanographic profiles of temperature, salinity and/or sound speed versus depth stored in the formats prescribed by the Master Oceanographic Observation Data Set (MOODS)

GOODS - oceanographic profiles of temperature, salinity and/or sound speed versus depth stored in the formats prescribed by the Global Oceanographic Observation Data Set (GOODS)

Fronts - ocean frontal position coordinates

Eddies - ocean eddy position coordinates

MODAS Profiles - oceanographic profiles of temperature, salinity and/or sound speed derived from the MODAS

Climatology Profiles - oceanographic profiles of temperature, salinity and/or sound speed derived from the climatology dataset.

Image - satellite imagery

3-Dimensional NIDAS Output - 3-dimensional (volumetric) gridded fields of temperature, salinity, and sound speed produced by the NIDAS application.

In addition to the primary data categories listed above, NIDAS may be configured by modification of default data elements contained in the “nidas_config.def” file described in Appendix C.

1.2.2 Functionality Overview

In MIL-STD 2167A (2.1) terminology, NIDAS is a Computer Software Configuration Item (CSCI). It is composed of four Computer Software Components (CSC), through which the functionality of NIDAS is achieved. The CSC’s are as follows:

a. **Graphical User Interface (GUI)** - provides window management, user interface and display functionality;

b. **Data Retrieval Module (DRM)** - provides access to the rdbms;

c. **Data Interactive Module (DIM)** - provides data processing methods, algorithms and visualization functionality;

d. **NIDAS Session Module (NSM)** - establishes an identifiable work session framework for organizing and monitoring production of NIDAS output.

Nidas has two external interfaces:

a. The **User-GUI** interface supports 1) user control of NIDAS using interactive techniques and 2) response/feedback to the user in the form of data display (graphical and numerical) and status indicators.

b. The **Files-GUI** interface provides access to files and data that are not resident within the internal rdbms.

The top-level (simplistic) architecture for NIDAS is shown in Figure 1.
Figure 1. Top-level modular structure of the Navy Interactive Data Analysis System (NIDAS). NIDAS is the Computer Software Configuration Item (CSCI). There are four Computer Software Components (CSC) and two external interfaces. (from "Design Document and Database Specifications for the Naval Interactive Data Analysis System (NIDAS) Version 1.0")

1.2.3 Support Overview

This manual is the core document for supporting NIDAS users. System specifications are described in the NIDAS design document (2.5). In addition to this manual, refer to documentation for integrated proprietary (commercial) software, such as Empress, and non-developed (government provided) software, such as the Naval Environmental Operational Nowcast System (NEONS).

1.3 Document Overview

The purpose of this document is to describe the functionality of NIDAS and the techniques/procedures that users may employ in producing a useful oceanographic product using NIDAS.

1.3.1 References

Documents and publications referenced within this manual are listed in Section 2. Where referenced in the text, the document name is followed by the appropriate subparagraph number within Section 2, where complete reference information may be found. Within Section 2, each listed reference is followed by a parenthetical listing of paragraph numbers within the manual where the reference is mentioned.
1.3.2 Format and Content

The format and content of this manual are in accordance with Data Item Description (DID) number DI-MCCR-80019A of the Department of Defense (DoD) Standard 2167A (2.1).

1.3.3 Definitions and Conventions

To simplify and standardize the communication of procedural details to the user, this manual adopts the following definitions and conventions:

Definitions:

button - When used in relation to the mouse device, a button is one of three pressure switches, which may be pressed (clicked) to control some feature of the screen display. When used in relation to the monitor display, a button is a labeled area of the on-screen graphical design that resembles a switch which can be made active by pressure.

click - The act of pressing a button on the mouse. The term "click on", or simply "click", is frequently used to indicate that the user should maneuver the mouse cursor to a specified location on the screen (usually an area designed to resemble a button) and press (click) the appropriate button on the mouse.

cursor - A graphical symbol that identifies a position on a computer monitor screen. A cursor is sometimes controlled by moving a mouse device; otherwise, it is controlled from the keyboard, usually with the arrow keys.

display - Synonymous with the computer monitor screen; also, to demonstrate or to show.

drag - The act of pressing and holding a button on the mouse device and moving the mouse to control a cursor's position on the monitor screen. The purpose of dragging the mouse device is to define an area on the screen or to move a graphical object to another location on the screen.

list - a simple series of words or numerals.

listbox - An outlined area of the display which contains a list of textual information. Selection of text within a list is accomplished by placing the mouse cursor over the appropriate entry and clicking a button on the mouse.

mouse - A hand controllable device used to interact with images displayed on the computer monitor screen. When a mouse is moved, a cursor on the screen moves in the same direction as the mouse. One or more buttons may be present on a mouse for invoking an action on screen at the corresponding cursor position.

pull-down menu - a listing of procedural options that appears in response to activation of an appropriately labeled (visible) button referred to as the menu header. Options are selected by clicking on the menu header to display the options, followed by clicking the button labeled to indicate the desired option.
rubberband - The act of dragging the mouse to define an area on the screen. A mouse button is pressed and held while the mouse is maneuvered to position the on-screen cursor at a desired final position; then, the mouse button is released.

screen - The display surface of a computer video monitor where images appear in response to bombardment by electrons.

scroll bar - The graphical image of a narrow bar with arrows embedded at both ends and, optionally, a movable (sliding) button between them. The scroll bar is used to position a portion of an image or text for viewing inside a bound area that is smaller than the whole image or text. Scrolling is accomplished by placing the mouse cursor on one of the arrows and pressing the mouse button. Scrolling may also be accomplished by placing the mouse cursor over the sliding button (if present) and dragging the sliding button to a new position along the scroll bar.

textbox - An outlined area of the display that contains textual information. Text in a textbox may sometimes be edited; however, the usual purpose of a textbox is to provide information to the user. A textbox is not scrollable.

widget - "...a graphic device capable of receiving input from the keyboard and the mouse and communicating with an application or another widget by means of a callback. Every widget is a member of only one class and always has a window associated with it." (from: OSF/Motif Programmer's Guide. Rev. 1.1. Open Software Foundation. Prentice Hall, Englewood Cliffs, NJ, 1991, p. GL-13.)

window - An outlined area of the screen whose contents are confined to the outlined boundary and controlled by user interaction (with buttons, menus, etc.). A window is usually a top level structure closely tied to the operating environment of the computer.

NOTE: Additional definitions are contained in Appendix A.

Mouse Button Convention: Most “click” or “select” operations with the mouse use the left button. Unless otherwise specified, instructions to “click” or “select” refer to the left mouse button. When a “click” or “select” using the middle or right mouse button is required, the specific mouse button will be indicated in the text; otherwise, the left mouse button should be assumed.

Non-interactive Textboxes: Textboxes with a buff-colored background are non-interactive. They provide information only and cannot be modified by the user.

2 REFERENCED DOCUMENTS

This user's manual either 1) contains references to the following documents, or 2) summarizes information contained in them which is appropriate for further reading:

2.1. DOD-STD 2167A “Defense System Software Development”, AMSC No. N4327, 29 Feb 88. (1.2.2) (1.3.2)

2.3. Naval Oceanographic Office Statement of Work of 26 Jan 93, Task Title: Development of the Naval Interactive Data Analysis System (NIDAS).

2.4. Mississippi State University proposal number 93-3-467 of 25 Mar 93, Title: Development of the Naval Interactive Data Analysis System (NIDAS), MSU Office of Sponsored Programs, P.O. Box 6156, Mississippi State, Mississippi 39762. (1.1)

2.5. “Design Document and Database Specifications for the Naval Interactive Data Analysis System (NIDAS), Version 1.0”, Technical Note 01-94, Mississippi State University, Center for Air Sea Technology, 29 October 1993. (1.2.4)


3 EXECUTION PROCEDURES

3.1 Initialization (Launching the Application)

NIDAS observes the standard procedure for executing an application in the UNIX/X-Windows environment. At the UNIX command line prompt, enter nidas. When X-Windows initialization procedures are complete, the NIDAS GUI or “Main Window” display will appear (e.g., If using “toms window manager” - “.twmrc“, a window skeleton appears on screen which must be maneuvered to the desired position on the monitor screen with the mouse. If using “motif window manager” - “.mwmrc“, the position of the main display is predefined and appears without any further action after entering nidas from the keyboard. Other window managers may involve different user action before the “Main Window” display appears.).

3.2 Initialization (Configuration) Files

Initialization, files contain default settings for maximum and minimum values of key search/query/retrieval parameters needed to configure NIDAS. The NIDAS initialization file is named “nidas config.def” and is listed in Appendix C. Questions regarding implementation of initialization files should be directed to the local NIDAS administrator or NIDAS Database.
Administrator (NDBA). If an initialization file cannot be found, the program will not execute and the user will be returned to the UNIX command line prompt.

3.3 Description of Display Windows

The screen displays of NIDAS are X-Windows client window objects. Window control adheres to standard X-Windows procedures. As illustrated by Figure 2, the "Main Window" display is subdivided into a 1) title area; 2) "Main Chart" area; 3) "Profile Composite Chart" area; 4) pull-down menu bar; 5) "Remark" textbox, 6) "Parameter versus Depth" textboxes and 7) a "Repaint" button. The functionality and purpose of each component of the display are described in the following sections. The DRM "Data Selection" window, Figure 9, is subdivided into three major regions: 1) title; 2) names of NIDAS data categories; and 3) buttons which support "Options", "Data" selection and data "Display". The DIM control window, Figure 23, is subdivided into two major areas: 1) title and 2) five available data editing choices. The NSM "Synthetic Admin Info" window, Figure 30, initiates all NSM procedures. It is subdivided into five major areas: 1) title 2) initiate 3) session boundary overlay 4) repeat and 5) terminate.

3.3.1 Main Window (NIDAS Graphical User Interface)

The NIDAS GUI manages the link between the user and NIDAS. Through the GUI, the user exercises available NIDAS control options. NIDAS provides pop-up windows for user interaction, as well as interactive functionality within the "Main Window" itself. The plotted display of data can be located in the "Main Chart" (left portion) and/or the "Profile Composite Chart" (right portion). The NIDAS "Main Window" is illustrated in Figure 2. While other NIDAS modules support their own suite of pop-up windows, the "Main Window" is the ultimate destination for all graphical output resulting from user interaction with them. The DRM, DIM, and NSM perform the preparatory data selection, data processing, and data management functions required to generate the visual displays that appear within the "Main Window".

Figure 2. NIDAS "Main Window" display screen.
3.3.1.1 Title

The title area of the NIDAS "Main Window" has no purpose except to identify the application as the "Naval Interactive Data Analysis System".

3.3.1.2 Main Chart

Referring to Figure 2, the "Main Chart" occupies the largest portion of the left-hand side of the "Main Window" display. The Main Chart displays plotted data in a geographical coordinate (map) context, using contours, points and/or area color fills. The colors used in plotting data within the Main Chart display are generally user selectable. The latitude coordinates range from 22 degrees North to 31 degrees North. The longitude coordinates range from 47 degrees East to 74 degrees East. The "Main Chart" is therefore confined (hard-wired) to the Persian Gulf/Arabian Sea region; however, future plans include the ability to interactively select other regions of the world. The "Main Chart" retains all datasets selected from the DRM during execution unless specifically removed by deselection. To remove a specific data display, deactivate the "Display" button for the appropriate data category within the DRM "Data Selection" window, Figure 9. When deactivated, the "Display" button will no longer be highlighted and the data plot for that data category will be removed from the "Main Chart".

3.3.1.3 Profile Composite Chart

The "Profile Composite Chart" occupies the largest area on the right side of the NIDAS "Main Window" display (see Figure 2). The "Profile Composite Chart" is used to plot temperature (°C), salinity (%) or sound speed (m/sec) versus depth (m) profiles. The profile composite chart accepts MOODS, GOODS, Climatology, and MODAS profiles. If the user selects non-profile datasets for display, they will appear as contours, lines, or points within the "Main Chart" portion of the "Main Window". To remove a plot display from the "Profile Composite Chart", deactivate the "Data" button for the appropriate profile data category within the DRM "Data Selection" window (Figure 9).

3.3.1.4 Menu Bar

The NIDAS "Main Window" contains a menu bar with interactive menu headers labeled "File", "Tools", and "Help". Each menu header provides access to additional NIDAS features. Figure 3 illustrates all available menu options. There are four options available under the "File" pulldown menu, five choices under "Tools" and four under "Help". Each of these menu options will be described in detail.
3.3.1.4.1 The File Pulldown Menu

The options (menu items) available from the "File" pulldown menu are "Main Chart", "Profile Chart", "Select Parameter" and "Exit".

"Main Chart" - The "Main Chart" menu item under the "File" pulldown menu offers three choices:

a. "Repaint" - Selecting the "Repaint" option removes (erases) any polygons or locations that have been created or overlaid within the "Main Chart". If there are no polygons or overlaid locations, no changes will be made to the "Main Chart".

b. "Default Region" - Selecting the "Default Region" option returns the "Main Chart" to its default scale or resolution subsequent to scaling (zoom) procedures that have enlarged the original resolution of the "Main Chart" display.

c. "Axis Options" - Selecting "Axis Options" opens a pop-up window that allows the user to change the latitude and longitude interval markings (tick marks) on the "Main Chart". The "Axis Options" pop-up window for the "Main Chart" is illustrated in Figure 4.a. Axis intervals are modified by entering new values for the latitude (Lat) and longitude (Lon) intervals within the textboxes in degrees of arc. Clicking the "Ok" button confirms the new values and closes the window. Clicking the "Exit" button closes the pop-up window, but makes no changes to pre-existing latitude/longitude tick marks.
Figure 4.a. The NIDAS "Axis Options" pop-up window for the "Main Chart". This pop-up window appears in response to selecting the "Axis Options" menu sub-item of the "Main Chart" menu item under the "File" menu header.

Profile Chart - The "Profile Chart" menu item offers option choices that are identical to the "Main Chart" menu item.

a. "Repaint" - Selecting the "Repaint" option removes (erases) any polygons or overlaid profiles that exist for "Profile Chart". If there are no polygons axis or overlaid profiles, no changes will be made to the "Profile Chart".

b. "Default Axis" - Selecting the "Default Axis" sets the axis and parameter selected to its default scale or resolution.

c. Axis Options - Selecting "Axis Options" opens a pop-up window that allows the user to change the X Min, X Max, Y Min, and Y Max range limits for the "Profile Composite Chart". The "Axis Options" pop-up window for the "Profile Composite Chart" is illustrated in Figure 4.b. Changes are made by selecting each textbox and entering a new maximum or minimum range limit. Clicking the "Ok" button confirms the new values and closes the window. Clicking the "Exit" button closes the pop-up window, but makes no changes to pre-existing range limit values.

Figure 4.b. The NIDAS "Axis Options" pop-up window for the "Profile Composite Chart". This pop-up window appears in response to selecting the "Axis Options" menu sub-item of the "Profile Chart" menu item under the "File" menu header.

Select Parameter - The "Select Parameter" menu item allows selection of the parameter to be displayed on the horizontal axis of the "Profile Composite Chart". Three choices are available: "Temp" (temperature), "Snd Speed" (sound speed) and "Salinity". These parameters will appear on labeled sub-menu items after clicking the "Select Parameter" menu item. After a parameter has been selected, the "Profile Composite Chart" will automatically adjust, if necessary, to accommodate the new parameter. If the selected parameter was previously designated to be the active parameter, there will be no change in the "Profile Composite Chart".
Exit - Upon clicking on the exit button, the "Exit" pop-up window displayed in Figure 5 is created. This pop-up window allows confirmation of the desire to exit (clicking the "Ok" button) or to return to the application (clicking the "Cancel" button).

Figure 5. The NIDAS "Exit" pop-up window. This pop-up window appears in response to selecting the "Exit" option from the "File" pulldown menu.

3.3.1.4.2 The Tools Pulldown Menu

The options (menu items) available from the "Tools" pulldown menu are "Status", "Create 3D", "Write 3D Grid", "Export" and "Log".

Status - The "Status" menu item provides time, date and plotting color information about each data type selected from the DRM "Data Selection" window (Figure 8). The status information is displayed within the "Data Selection Status" pop-up window, which is illustrated in Figure 6. Vertical and horizontal scrollbars are provided to allow viewing of information that extends beyond the pop-up window boundary. To close the "Data Selection Status" pop-up window, click the "Exit" button located in the lower right corner.

Figure 6. The Tools "Data Selection Status" pop-up window. This pop-up window appears in response to selecting the "Status" option from the "Tools" pulldown menu.

Create 3D - The "Create 3D" menu item 1) creates a NIDAS 3-dimensional (3D) volumetric grid from the provinces created during a session and 2) ingests the 3D volume into the NIDAS database. If a MODAS grid is associated with the session, it will also be ingested. NIDAS provides messages in the "Remark" textbox about data ingestion progress and any errors encountered during 3D dataset creation and ingestion.

Write 3D Grid - The "Write 3D Grid" provides the capability to export NIDAS and MODAS datasets to files. The "Export: Data" pop-up window (Figure 7.a) appears when the "Write 3D Grid menu item is clicked. First, select the desired data type, "Modas" or "Nidas" by clicking one of the buttons provided. Default dates and filenames for temperature ("Temp"), salinity ("Sal") and sound speed ("SndSpd") will then be displayed within the text widgets. Next,
select a date and either 1) use the default file names or 2) select (click) a file name and change it from the keyboard (press <return> after making the entry). To output the dataset to a file, select the “Write” button located in the lower right corner. To close the “Export: Data” pop-up window, click the “Exit” button, also located in the lower right corner.

Figure 7.a. The Tools “Export: Data” pop-up window. This pop-up window appears in response to selecting the “Write 3D Grid” option from the “Tools” pulldown menu.

Export - The Tools “Export” menu item supports exportation of MODAS, Climatology, NIDAS 3D, MOODS or GOODS datasets in binary or ASCII format. The “Export Data” pop-up window illustrated in Figure 7.b appears in response to selection of the “Export” menu item. It provides a header entry textboxes, suggested (default) filename(s) and buttons for selecting binary or ASCII output. Before datasets can be exported, at least one of the exportable data types listed above must have been selected, and, polygons must have been constructed. Depending upon the data types displayed, the “Export” menu lists filenames in a textbox for each data type and a textbox for entry of header information. The user may enter header information from the keyboard after clicking the appropriate “Header” textbox (press <return> upon completion of text entry). Similarly, new file names may be entered for each data type. To export a dataset to a file, click the “Binary” or “Ascii” button; then click the “Ok” button located in the bottom right corner. To restore all values to their original default settings, click the “Reset” button. To close the “Export Data” pop-up window, click the “Exit” button.

Figure 7.b. The Tools “Export Data” pop-up window. This pop-up window appears in response to selecting the “Export” option from the “Tools” pulldown menu.

Log - The “Log” menu item provides a log (record) of data types that are turned on or off and other significant events that have occurred during a NIDAS session. This information is provided via the “User Interactions” pop-up window illustrated in Figure 7.c. Vertical and horizontal scrollbars allow viewing of information that may extend beyond the pop-up window’s viewing boundary. To close the “User Interactions” pop-up window, click the “Exit” button located in the lower right corner.
3.3.1.4.3 The Help Pulldown Menu

The "Help" pulldown menu offers on-line assistant to the user. Help is available on "Layout", "Data Selection", "Synthetic Admin" and "Data Analysis" from the menu items that appear when the "Help" menu header is selected. Help on each subject is provided in a series of pop-up help screen windows that appear in response to menu item selection. When/if additional help is available, it may be accessed by clicking the "Help" button located in the lower right corner of a help screen. To close a help screen, click the "Ok" button, located in its lower left corner. "Layout" help screens provide a detailed description of the NIDAS Interface.

3.3.1.5 Remark

The buff-colored "Remark" textbox is located in the lower left corner of the "Main Window" display. The "Remark" textbox provides notification of errors, event status and communicates instructions for follow-on interaction by the user.

3.3.1.6 Parameter vs. Depth

The buff-colored "Temp" ("Sal" or "SndSpeed") and "Depth" textboxes are located in the lower right corner of the "Main Window" display. The textboxes are activated when the mouse cursor is positioned within the "Profile Composite Chart" during synthetic profile construction. The textbox contents reflect the temperature (salinity or sound speed) values and the depth at the cursor location. The values change in response to cursor movement. The textboxes are deactivated when the cursor is moved outside the "Profile Composite Chart" or upon termination of the synthetic profile construction mode.

3.3.1.7 Repaint

The "Repaint" button is located in the lower right corner of the "Main Window" display. "Repaint" eliminates all polygons and overlaid position plots on the "Main Chart", and overlaid profiles on the "Profile Composite Chart". Nothing happens in response to clicking "Repaint" if there are no polygons, position plots or overlaid profiles.
3.3.2 Data Retrieval Module (DRM)

The Data Retrieval Module (DRM) controls the display and selection of data for the NIDAS CSCI. User interaction with the DRM is handled via the "Data Selection" window shown in Figure 8, below. There are three choices for each data type listed in the "Data Selection" window. They are "Display", "Data", and "Options". The "Display" buttons select data types to be viewed in the "Main Chart" or "Profile Composite Chart" within the NIDAS "Main Window" display.

![Data Retrieval Module (DRM)](image)

Figure 8. Illustration of Data Retrieval Module (DRM) "Data Selection" window. This window lists the available data categories, supports data selection and allows access to display and other options.

The "Data" buttons produce tailored dialog pop-up windows that allow selections from available parameters contained in the dataset. The "Options" buttons produce data dialog pop-up windows, tailored to each data type, offering other user options such as color. The functionality of the "Display", "Data" and "Options" buttons are described for each data type/category in the following subsections.

3.3.2.1 Data Selection - BATHY (Bathymetry)

**Display:** Selecting the BATHY "Display" button produces a contour plot of the bottom depth on the "Main Chart.

**Data:** Bathymetry does not vary with time or day. It is determined by the region designated for the "Main Chart". The BATHY "Data" button is an inactive button; i.e., no action occurs when it is selected.

**Option:** When the BATHY (bathymetry), MODAS or CLIMO (climatology) "Option" button is clicked, a pop-up window is produced which allows modification of the maximum and minimum data values and the interval between plotted contours (see Figure 9). To modify values, select the appropriate text widget, enter the desired value from the keyboard and press the <return> key. A pulldown "Colors" menu permits selection of the color in which the plot will be drawn. The selected color is displayed in the "Color" textbox. The "Ok" button accepts the changes and removes the pop-up window. The "Reset" button restores all values to their defaults.
3.3.2.2 Data Selection - MODAS

**Display:** Selecting the MODAS “Display” button produces a contour plots of MODAS data fields on the “Main Chart”.

**Data:** Activation of the MODAS “Data” button produces the “MODAS Data” pop-up window illustrated in Figure 10. The “MODAS Data” pop-up window supports selection of the MODAS parameter (Temperature, Salinity or Sound Speed, etc.), the depth level and the desired date/time. The selection procedure must be ordered to allow successful data retrieval from the NIDAS database. To restore the default state, click the “Reset” button. Follow these steps to retrieve MODAS data subsets:

1) Select a parameter from the “Parameters” listbox. This will activate the “Levels” and “Dates” listboxes with listings of all available levels and dates, respectively, for the selected parameter.

2) Select one level and one date. (Note: Level 0.000 is selected by default and will be highlighted).

3) Click the “Read” button to initiate data retrieval.

4) If other parameters, levels or date/times are needed, return to step 1.

The “MODAS Data” pop-up window is closed by clicking the “Exit” button. Clicking the “Reset” button will restore the default state.
Figure 10. DRM "MODAS Data" pop-up window for MODAS and MODASPROF data types. This pop-up window is displayed in response to clicking the "Data" button for MODAS or MODASPROF within the DRM "Data Selection" window.

Option: Refer to the Option subparagraph contained in Section 3.3.2.1 "Data Selection - BATHY (Bathymetry)" and to Figure 9.

3.3.2.3 Data Selection - CLIMO (Climatology)

Display: Selecting the CLIMO "Display" button produces a contour plot of Climatology data fields on the "Main Chart".

Data: Activation of the CLIMO "Data" button produces the "CLIMO Data" pop-up window illustrated in Figure 11. The "CLIMO Data" pop-up window supports selection of the Climatology parameter (Temperature, Salinity or Sound Speed, etc.), the depth level, and the season. The selection procedure must be ordered to allow successful data retrieval from the NIDAS database. To restore the default state, click the "Reset" button. Follow these steps to retrieve climatology data subsets:

1) Select a parameter from the "Parameters" listbox. This will activate the "Levels" and "Dates" listboxes with listings of available levels and dates, respectively, for a selected parameter.

2) Select one level and one season. (Note: Level 0.000 is selected by default and will be highlighted).

3) Click the "Read" button to initiate data retrieval.

4) If other parameters, levels or date/times are needed, return to step 1.

The "CLIMO Data" pop-up window is closed by clicking the "Exit" button. To reiterate, clicking the "Reset" button will restore the default state.
Figure 11. DRM “CLIMO Data” pop-up window for CLIMO (climatology) and CLIMOPROF (climatology profile) data types. This pop-up window is displayed in response to clicking the “Data” button for CLIMO or CLIMOPROF within the DRM “Data Selection” window.

**Option:** Refer to the Option subparagraph contained in Section 3.3.2.1 “Data Selection - BATHY (Bathymetry)” and to Figure 9.

### 3.3.2.4 Data Selection - COAST (Coastline)

**Display:** Clicking the “Display” button associated with the COAST (coastline) data type plots the coastline on the “Main Chart”.

**Data:** Clicking the “Data” button associated with the COAST (coastline) data type produces the “Coastline Data” pop-up window illustrated in Figure 12. The “Coastline Data” pop-up window allows selection of the coastline resolution (1, 3, 8, or 20 kilometers) which requires the user to select a particular type of coastline. When the “Coastline” button is clicked, a pull-down menu lists the four coastline resolutions. The selected resolution is displayed in textbox to the right of the pulldown menu. Clicking the “Ok” button accepts any changes made to coastline resolution and closes the pop-up window. Clicking the “Reset” button restores the coastline resolution to its default (pre-existing) value.

Figure 12. DRM “Coastline Data” pop-up window for the Coastline, Fronts, and Eddies data types.

**Option:** Selecting the “Option” button associated with the COAST (coastline) data type within the DRM “Data Selection” window produces the “Coastline Options” pop-up window illustrated in Figure 13. A “Colors” pulldown menu offers a choice among six different color options in which a coastline may be displayed on the “Main Chart”. The selected color is displayed in the textbox to the right of the pulldown menu. Clicking the “Ok” button accepts the indicated
color and closes the “Coastline Options” pop-up window. Clicking the “Reset” button restores the original color, which may be accepted (by clicking “Ok”) or modified again (using the “Colors” pulldown menu).

Figure 13. DRM “Coastline Options” pop-up window for the Coastline and Climatology Profile data types.

3.3.2.5 Data Selection - MOODS

**Display:** The display button for MOODS displays the MOODS location information on the Main Chart and profiles of depth vs. temperature on the Profile Chart for the selected data set.

**Data:** Upon selection of the MOODS data button, the MOODS data selection pop-up window, Figure 14, will appear. This pop-up window contains numerous user-selectable options and status indicators within its Data Selection and Selection Status boards. The “Reset” button replaces current parameter range values with the original (default) settings. The “Read” button activates MOODS data retrieval from the NIDAS database, using the parameter range criteria displayed within the “Selection Status” board. The “Remark” textbox within the “Main Window” displays “Reading MOODS Data” during the data retrieval operation and “Finished Reading MOODS Data” when the retrieval operation is completed. The “Exit” button closes the MOODS data selection pop-up window.

**“Selection Status” Board** - The “Selection Status” board occupies the right hand portion of the MOODS data selection pop-up window. The “Minimum” and “Maximum” buttons are used to determine whether changes to parameters made within the “Data Selection” board will be applied to the minimum or maximum range limit, respectively. The last minimum and maximum range limits established before closing the MOODS data selection pop-up window will be used to retrieve MOODS data. The “Selection Status” board displays (in textboxes) all parameters which may be set within the “Data Selection” board.

**“Data Selection” Board** - The “Data Selection” board is used to define maximum or minimum parameter range limits which are displayed within the “Selection Status” board. Scrollable listboxes allow selection of Classification Code, Instrument Type, Source Code and Month. To select a parameter value from a listbox, locate the desired parameter value, using the scrollbar if necessary, and click its text region. The new parameter value will then appear within the appropriate text display box (as a maximum or minimum range limit) within the “Selection Status” board. “Cruise ID” numbers, “Water Depth”, “Latitude” and “Longitude” values must be entered from the keyboard into the labeled textboxes. To perform these entries, activate the desired textbox by clicking within the text display region and enter the information from the keyboard (followed by pressing the <return> key). The “Number of Parameters” scrollbar may be manipulated (by dragging) to define the maximum and minimum parameter vs. depth configurations for MOODS data:
1 - depth and salinity;
2 - depth and temperature;
3 - depth, temperature and salinity;
4 - depth and sound speed.

Clicking the “Time” button produces the “TIME SELECTION” pop-up window displayed in Figure 15. Time range limits may be set independently of “Maximum” and “Minimum” button activation within the “Selection Status” board. “Start” and “End” time limits may be established via a single access to the “TIME SELECTION” pop-up window. Maximum and minimum time/date range values may be set by keyboard entry or via the arrow buttons. The selected “Start” and “End” times/dates are displayed in the textboxes next to the “Start” and “End” buttons as well as the textboxes next to the arrow buttons. Clicking the “Reset” button returns the time/date ranges to their original default values. When the “Start” and “End” times/dates have been defined, clicking the “Exit” button will close the pop-up window and transfer the defined time/date values to the “Selection Status” board. Each selection made in the Data Selection is immediately displayed in the appropriate textboxes of the “Selection Status” board.

![Figure 14. DRM Data Selection pop-up window for the MOODS data type.](image-url)
Figure 15. DRM "Time Selection" pop-up window for setting MOODS date/time criteria.

Option: The "MOODS Options" pop-up window illustrated in Figure 16 supports specification of 1) up to three date ranges (+/-) centered on the listed "Center Date" (Julian), 2) colors for plotting MOODS profiles, 3) colors for plotting polygons, 4) colors for sea surface temperature (Sst), and 5) an "On/Off" toggle button for activating/deactivating display of sea surface temperature. The Julian center date is automatically calculated from the dataset and listed in the "Center Date" text box. The user can also enter a different center date by selecting the "Center Date", entering a new date from the keyboard, and pressing the <return> key. Below the "Center Date" textbox are three textboxes labeled "+/2", "-" and "+". The value entered in the "+/-" textbox is added and subtracted from the center date to obtain a date range. To further reduce the lower limit of the date range, enter a number into the "-" textbox. Similarly, a number may be entered into the "+" textbox to increase the upper limit of the date range. For each Julian range entered, the user may select a color for displaying profiles falling within that time window, and, a color for profiles within polygons within that time window. When clicked, the "Color" button produces a pulldown menu offering six color options. A color may be selected by dragging the mouse cursor over the desired color and releasing. The selected color will be displayed within the "Color" textboxes. Display of a sea surface temperature band is controlled via the "Sst On/Off" toggle button. Setting the color of profiles falling within the established band is accomplished via the "Sst Color" pulldown menu in the same manner prescribed for setting profile plotting colors for the Julian date range and polygons. Clicking the "Reset" button returns all values to their original defaults. Clicking the "Ok" button closes the "MOODS Options" pop-up window, accepting the criteria established therein.
3.3.2.6 Data Selection - GOODS

**Display:** The “Display” button for GOODS 1) plots the location of GOODS profiles on the “Main Chart” and 2) plots GOODS parameter profiles vs. depth on the “Profile Composite Chart” for the selected data set.

**Data:** The GOODS “Data” button evokes the GOODS “Data Selection/Selection Status” pop-up window illustrated in Figure 17. The “Selection Status” board (right hand) portion of the pop-up window displays the maximum and minimum range limits for location (latitude/longitude), time and GOODS parameters (sea surface temperature/salinity/depth) in uneditable textboxes. Values for these range limits are determined within the “Data Selection” board (left hand) portion of the pop-up window. If the “Minimum” button is active, values determined via the “Data Selection” board are the minimum range limits. If the “Maximum” button is active, values determined via the “Data Selection” board become maximum range limits. Range values derived in the “Data Selection” board will be displayed in the appropriate column (minimum or maximum) of textboxes within the “Selection Status” board. Within the “Data Selection” board, widgets are provided to select the “Number of Parameters” and the “Min” and “Max” date. These values can be determined with the slide bar. “Min Date” and “Max Date” may also be entered via the keyboard into the appropriate textbox, followed by pressing the <return> key. Maximum and minimum latitude and longitude range limit values must be entered from the keyboard, followed by pressing the <return> key. The “Number of Parameters” slidebar may be manipulated (by dragging) to define the maximum and minimum parameter vs. depth configurations for GOODS data:

1. depth and salinity;
2. depth and temperature;
3. depth, temperature and salinity;
4. depth and sound speed.

When using the slide bar to change the “Min Date” or “Max Date”, the date is displayed in the Data Selection textboxes. The date’s format is year/month/day:hour as illustrated in Figure 17. To retrieve GOODS data that lies within the location/time/parameter criteria, click the “Read” button. To restore the original default values, click the “Reset” button. To close the window, click the “Exit” button.
Figure 17. DRM Data Selection pop-up window for the GOODS data type.

Option: The GOODS "Options" button evokes the "MOODS Options" pop-up window discussed in Section 3.3.2.5 and illustrated in Figure 16.

3.3.2.7 Data Selection - FRONTS

Display: The Fronts "Display" button behaves in a similar manner to the Bathy "Display" button. Fronts associated with the selected ocean parameter are plotted on the "Main Chart" portion of the "Main Window".

Data: The Fronts "Data" button produces the "Fronts Data" pop-up window illustrated in Figure 18. The "Fronts Data" pop-up window supports selection of a time/date of interest from its scrollable listbox. A time/date is selected by clicking on the appropriate line of text to highlight the choice. To confirm the choices click the "Ok" button. To remove the selection, click the "Reset button.

Figure 18. DRM "Fronts Data" pop-up window for the Fronts and Eddies data types.

Option: When the Fronts, Eddies, ModasProf, ClimoProf or NIDASProf "Options" button is clicked, the "MODAS Profile Options" pop-up window (Figure 19) is created which allows the user to select a plotting color. This pop-up window provides a pull-down menu with six different color options. To select a color, click on the "Colors" menu header, drag the cursor to the desired color and release the mouse button. The new color will be listed in the textbox. To restore the original color, click the "Reset" button. To confirm selection of the current color and close the "MODAS Profile Options" pop-up window, click the "Ok" button.
3.3.2.8 Data Selection - EDDIES

Display: The Eddy “Display” button controls plotting of eddy information for the selected ocean parameter within the “Main Chart” display. Its action is similar to the Bathy “Display” button; i.e., deselection of the Eddy “Display” button removes the plotted eddy information from the “Main Chart”.

Data: Refer to the Data subparagraph of Section 3.3.2.7 “Data Selection - Fronts” and to Figure 18. The “Eddies Data” pop-up window functions in the same manner as the “Fronts Data” pop-up window.

Option: Refer to the Option subparagraph contained in Section 3.3.2.7 “Data Selection - Fronts” and to Figure 19.

3.3.2.9 Data Selection - MODASPROF

Display: When the MODASProf “Display” button is clicked, a flag is set to plot MODAS profiles on the “Profile Composite Chart” provided a polygon-defined region exists on the “Main Chart”.

Data: No data can be selected. MODASPROF relies on MODAS data.

Option: Refer to the Option subparagraph contained in Section 3.3.2.7 “Data Selection - Fronts” and to Figure 19.

3.3.2.10 Data Selection - CLIMOPROF

Display: When the CLIMOPProf “Display” button is clicked, a flag is set to plot Climatology profiles on the “Profile Composite Chart” provided a polygon-defined region exists on the “Main Chart”.

Data: No data can be selected. CLIMOPROF relies on climatology data.

Option: Refer to the Option subparagraph contained in Section 3.3.2.7 “Data Selection - Fronts” and to Figure 19.

3.3.2.11 Data Selection - IMAGE

Display: The Image “Display” button displays the image for the selected date within the “Main Chart”.

Data: When the Image “Data” button is activated, the “Image Data” pop-up window (Figure 20) appears. The “Image Data” pop-up window contains a scrollable listbox of dated satellite images.
images. To select an image, click the cursor within the text region containing the date/serial number of the desired image. The text line will be highlighted. Click the “Read” button to retrieve the image data. Click the “Reset” button to return to the default state (first date/serial number preselected). To confirm the image selection and close the “Image Data” pop-up window, click the “Exit” button.

Figure 20. DRM “Image Data” pop-up for the Image data type.

Option: Clicking the Image “Options” button produces the “Image Options” pop-up window with functionality similar to that of the “Bathy Options” and “Modas Options” pop-up windows depicted by Figure 9. The “Image Options” pop-up window supports selection of the data value range (minimum and maximum) and the plotting interval. Enter values in the text boxes and press the <return> key. The “Colors” pulldown menu is deactivated for the Image data type. To restore the default state, click the “Reset” button. To accept the range and interval (modified or not), click the “Ok” button.

3.3.2.12 Data Selection - NIDAS3D

Display: The display button for NIDAS3D displays NIDAS3D information for the parameters selected via the NIDAS3D “Data” button.

Data: Activation of the NIDAS3D “Data” button produces the “3D Volume Data” pop-up window illustrated in Figure 21. The “3D Volume Data” pop-up window supports selection of a NIDAS3D parameter (temperature, salinity or sound speed, etc.), the depth level and the desired date/time. The selection procedure must be ordered to allow successful data retrieval from the NIDAS database. To restore the default state, click the “Reset” button. Follow these steps to retrieve NIDAS3D data subsets:

1) Select a parameter from the “Parameters” listbox. This will activate the “Levels” and “Dates” listboxes with listings of all available levels and dates, respectively, for the selected parameter.

2) Select one level and one date. (Note: Level 0.000 is selected by default and will be highlighted).

3) Click the “Read” button to initiate data retrieval.

4) If other parameters, levels or date/times are needed, return to step 1.

The “3D Volume Data” pop-up window is closed by clicking the “Exit” button. To reiterate, clicking the “Reset” button will restore the default state.
Figure 21. DRM “3D Volume Data” pop-up window for the NIDAS3D data type.

**Option:** The NIDAS3D “Options” button produces a pop-up window that functions in the same manner as the “Bathymetry Options” pop-up window described in section 3.3.2.1 and illustrated in Figure 9.

### 3.3.2.13 Data Selection - NIDASPROF

**Display:** Clicking the NIDASPROF “Display” button sets a flag to plot NIDAS profiles on the “Profile Composite Chart” when a polygon has been constructed on the “Main Chart”.

**Data:** No data can be selected. NIDAS data is used to construct NIDAS profiles.

**Option:** Refer to the Option subparagraph contained in Section 3.3.2.7 “Data Selection - Fronts” and to Figure 19.

### 3.3.3 Data Interactive Module (DIM)

The DIM supports manipulation of ocean data in the following ways:

1) identification of data subsets by constructing polygons within the “Main Chart” or “Profile Composite Chart”;
2) enlargement of resolution (zoom) for improved interpretation/analysis;
3) displaying transections (slices) through a dataset;
4) creating synthetic datasets or subsets;
5) displaying a single MODAS profile.

The DIM “Data Editing” window (Figure 22) controls selection of data manipulation options within NIDAS. Only one of the five available options can be active at any time. To activate an option, click its associated button.
3.3.3.1 Data Editing - Polygon

After selecting the "Polygon" button in the DIM "Data Editing" control and option selection window, polygon construction functions become active within either the "Main Chart" or the "Profile Composite Chart. The following rules apply in constructing a polygon:

1) The left mouse button is used to select the “Main Chart” or “Profile Composite Chart” for polygon construction. Simply pace the mouse cursor within the border of the "Main Chart" or the "Profile Composite Chart" and click the left mouse button.

2) The middle mouse button is used to establish the corner points of a polygon. Maneuver the cursor to the position desired for a corner point and click the middle mouse button. At least three points must be defined in this manner to create a polygon.

3) The right mouse button is used to close the polygon and indicate that definition of polygon corner points has terminated. The three (or more) polygon corner points will be connected, in the order in which they were created, to form the polygon. If the polygon does not appear to be drawn correctly, click the "Repaint" button located in the lower right corner of the "Main Window" display to remove existing polygons. If less than three corner points were defined before clicking the right mouse button, a message will appear in the “Remark” textbox stating “Polygon should have at least three points. Start again.”

3.3.3.2 Data Editing - Zoom

After selecting the "Zoom" button in the DIM "Data Editing" control and option selection window, the zoom options pop-up window (Figure 23) will appear. If the “Zoomed Profiles Only” button is selected, only those profiles within the zoom subregion of the “Main Chart” will be plotted within the “Profile Composite Chart”. If the “Overlay Zoomed Profiles” button is selected, profiles within the zoom subregion will be plotted on top of any existing profiles within the “Profile Composite Chart”. When the “Exit button is clicked, the zoom options pop-up window is closed and the “Zoom” function is activated to specify the subregion for enlargement within the “Main Chart”. To specify the subregion, use the rubberband technique defined in Section 1.3.3 (Definitions and Conventions). The “Zoom” function will not work unless the specified subregion is completely visible within the “Main Chart” window. Once the subregion for enlargement has been specified, the “Main Chart” window will display it. Profiles within the zoomed subregion will be plotted within the “Profile Composite Chart” will display the zoomed profiles in accordance with the plotting option selected in the zoom options pop-up window. To reduce the “Main Chart” display back to its normal region depiction, select the “Default Region” menu item found under the “File” menu header (Section 3.3.1.4.1).
3.3.3.3 Data Editing - Transect

When the "Transect" button in the DIM "Data Editing" control and option selection window is clicked, the "Main Chart" is activated for definition of a transecting slice through the dataset. Use the left mouse button to define the starting and ending points for the transect. Then, click the middle mouse button to indicate completion of endpoint definition. The transect options pop-up window (Figure 24) will then appear. Within the transect options pop-up window, select an appropriate data type by clicking either the "MODAS", "Climo" (climatology) or NIDAS button. (NOTE: MODAS, Climatology or NIDAS data must be selected and displayed in the "Main Chart" using the DRM before clicking the "Transect" option in the DIM "Data Editing" control and option selection window; otherwise, the transect option will not work. After selecting a data type for application of the transect function, the "Remark" textbox will inform that proper data has not been selected.) Next, enter the preferred spacing, minimum depth, maximum depth, and contour interval by clicking to activate each textbox and entering values from the keyboard (press <return> when each textbox entry is completed). Click the "Exit" button to close the transect options pop-up window. A graphical plot of the transect will then be displayed within its own pop-up window. To close the transect display pop-up window, click anywhere within its boundary.

3.3.3.4 Data Editing - Synthetic

When the "Synthetic" button in the DIM "Data Editing" control and option selection window is clicked, the "Synthetic Profile" pop-up window (Figure 25) appears. The "Synthetic Profile" pop-up window supports creation of provinces and their associated polygons via the "Repeat" and "Last Polygon" option buttons. To restore the default state, click the "Reset" button. To close the "Synthetic Profile pop-up window, click the "Ok" button. Before performing synthetic profile construction, the following requirements must be met:
1) The NIDAS Session Module (NSM) must be active and a “New” or “Unclosed” session must have been selected in order to create or update provinces and their associated profiles.

2) The “Last Polygon” option requires preselection of a ”New” or “Unclosed” session and that a polygon already exist.

3) The “Repeat” option requires preselection of a “Repeat” session.

![Figure 25. The DIM “Synthetic Profile” pop-up window.](image)

If “Repeat” is selected, a window will appear displaying all provinces associated with the session. Use the left mouse button to select a province. Use the middle mouse button to confirm the selection. If no province is to be selected, click the right mouse button. If a province is selected, the “Repeat Dialog” pop-up window (Figure 26) will be displayed. The “Repeat Dialog” pop-up window incorporates the following option buttons:

1) “Plot Province” - activation of the “Plot Province” button plots the selected province in the “Main Chart”.

2) “Plot Synthetic” - activation of the “Plot Synthetic” button plots the synthetic profile for the selected province in the “Profile Composite Chart”.

3) “Draw New Synthetic” - activation of the “Draw New Synthetic” button permits creation of a new synthetic profile within the “Profile Composite Chart”. To create a new synthetic profile, use the left mouse button to identify the points on the profile. When finished, click the middle mouse button to confirm completion and connect the points of the new synthetic profile. To abort the synthetic profile creation process, click the right mouse button at any time before confirming completion. The newly created synthetic profile will not replace the existing profile for the province until the “Save” button is selected within the “Repeat Dialog” pop-up window.

4) “Edit Synthetic Profile” - activation of this button produces an “Edit Dialog “ pop-up window, Figure 27. The “Edit Dialog” pop-up window allows editing of an existing synthetic profile. To edit an existing profile, the Repeat session must also be an Unclosed session. Follow these steps to edit a synthetic profile:

a) Click the “Pick Two Points” button within the “Edit Dialog” pop-up window (Figure 27).

b) On the “Profile Composite Chart”, use the left mouse button to select start and end markings indicating the range where the editing will occur. Click the middle mouse button to confirm the start/end point selection. Horizontal lines will be plotted to identify the depths where profile points may be edited. Click the right mouse button to terminate the procedure if no editing has been performed.
c) Click “Edit Points” to enable placement of new profile points within the editing range.

d) Place new profile points within the editing range by clicking the left mouse button. Click the middle mouse button to indicate completion and plot the new synthetic profile in the “Profile Composite Chart”. The new profile will then replace the old profile for that province in the database. Click the right mouse button to terminate the procedure if no editing has to be performed.

4) “Scale” - Refer to the Axis Option subparagraph for the “Profile Composite Chart” contained in Section 3.3.1.4.1 “File Pulldown Menu” and to Figure 4.b.

5) “Save” - selecting the “Save” button, saves the Repeat session province and its associated profile to the Unclosed session.

6) “Exit” - closes the “Repeat Dialog” pop-up window.

![Figure 26. The DIM “Repeat Dialog” pop-up window.]

![Figure 27. The DIM “Editing Dialog” pop-up window.]

If a polygon has been created and an Unclosed session is active, selecting “Last Polygon” from the “Synthetic Profile” pop-up window is selected from the DIM “Data Editing” control and option selection window, the polygon will be displayed in the “Main Chart”. The “Remark” textbox will display a message instructing the user to create a synthetic profile in the “Profile Composite Chart”. To create a new synthetic profile, use the left mouse button to define points on the profiles. Click the middle mouse button to confirm completion of profile point definition and to connect the profile points into a line (plotted profile). Before confirming completion of profile definition, clicking the right mouse button will abort the synthetic profile creation procedure. After confirming completion of profile point definition by clicking the middle mouse button and creation of the synthetic profile, the pop-up window shown in Figure 28 will appear. Clicking the “Ok” button will save the new synthetic profile to the database within the active Unclosed session and close the pop-up window. To close the pop-up window without saving the profile, click the “Cancel” button.

29
3.3.3.5 Data Editing - Single MODAS

A MODAS dataset must be plotted and selected before accessing the Single MODAS function; otherwise the message “MODAS data is not drawn” will be displayed within the “Remark” textbox when an attempt is made to apply the Single MODAS procedure. To avoid this message, select a proper dataset and display it using the facilities of the DRM. After selecting the “Single MODAS” button in the DIM “Data Editing” control and option selection window, place the cursor inside a pre-existing polygon in the “Main Chart” and click to identify a point. A triangle will be plotted at the position where the cursor was clicked. If there are no plotted polygons, one must be constructed before applying the Single MODAS function. If an attempt is made to define a point not inside a polygon, an error message will appear within the “Remark” textbox. Another point must then be defined in order to proceed. A Single MODAS profile will be plotted in the “Profile Composite Chart” for each point identified in the “Main Chart”. To remove a polygon and its Single MODAS point indicators, select the “Repaint” button within the “Main Window” display. The user may select more than one point inside the polygon and all selected points will be displayed on the profile window.

3.3.4 NIDAS Session Module (NSM)

The NSM supports session management. It establishes New NIDAS sessions or provides access to Unclosed sessions. A NIDAS session environment provides the facilities to construct provinces and the oceanographic profiles associated with them. Provinces (and their associated profiles) may be selected from previously closed sessions. Unclosed sessions may be displayed for construction of provinces. High level control of the NSM is achieved through options available in the NSM “Synthetic Admin Info” pop-up window (Figure 29). The “Synthetic Admin Info” control window contains four control sections: “Initiate”, “Session Boundary Overlay”, “Repeat” and “Terminate”.

Figure 28. Profile Saving Dialog pop-up window from the DIM “Last Polygon” Option.
3.3.4.1 NSM Initiate - New

When selected, the “New” button within the NSM “Initiate” section of the “Synthetic Admin Info” control window responds by displaying the “New Session” pop-up window (Figure 30), which supports creation of a New session. To create a New session, proceed as follows:

1) Click to highlight the “Session” textbox. Enter a session name from the keyboard followed by pressing <return>.

2) Click to highlight the “Region” textbox. Enter a region name from the keyboard followed by pressing <return>.

3) Click one of the buttons within the “Type” section of the pop-up window. There are five choices [“Production”, “Clim_Const” (climatology construction), “Demo”, “Request” and “Other”].

4) Click either the “Practice” or “Real” button within the “Mode” section of the pop-up window.

5) Click either the “Classified” or “Unclassified” button within the “Classification” section of the pop-up window to indicate the level of security.

6) Click “Ok” to store the New session information in the NIDAS database, or, click “Exit” to close the “New Session” pop-up window without creating a New session.

7) Any provinces and associated profiles created while the New session is active will be stored within it.
Near the bottom of the “New Session” pop-up window, there is a listbox with labeled column headings (“Model Type”, “Volid”, “Date” and “Stamp Time”). Use this textbox to (optionally) associate MODAS datasets with the New session. All other information must be completely defined.

![New Session Pop-up Window](image)

**Figure 30. The NSM “New Session” pop-up window.**

### 3.3.4.2 NSM Initiate - Unclosed

When selected, the “Unclosed” button within the NSM “Initiate” section of the “Synthetic Admin Info” control window responds by displaying the “Unclosed Sessions” pop-up window (Figure 31), which supports opening of Unclosed sessions. Unclosed sessions are those that were created at an earlier time within the “New Session” pop-up window (Figure 30), but have not been specifically and formally closed. To open an Unclosed session, click the mouse to highlight it in the list of Unclosed sessions displayed in the listbox. Then, click the Ok” button. Information pertaining to the selected session will be retrieved from the database and any new provinces (and associated profiles) will be stored with it when saved. To close the “Unclosed Sessions” pop-up window, click the “Exit” button.
Figure 31. The NSM "Unclosed Sessions" pop-up window (form also used for "Overlay Sessions" and "Repeat Sessions").

3.3.4.3 NSM Session Boundary Overlay - Display

Clicking the "Display" button within the "Session Overlap Boundary" section of the NSM "Synthetic Admin Info" control window plots provinces for the New or Unclosed session within the "Main Chart" display.

3.3.4.4 NSM Session Boundary Overlay - Data

Clicking the "Data" button within the "Session Overlap Boundary" section of the NSM "Synthetic Admin Info" control window produces the NSM Session Boundary Overlay - Data pop-up, which is similar to Figure 31. This pop-up window allows access to unclosed sessions which were created at an earlier time as a New session. Available sessions are listed in the pop-up window listbox. To select a session, click the text line containing information about the desired session to highlight it. Once the desired session is highlighted, click the Ok" button to retrieve the session from the database. To close the NSM Session Boundary Overlay - Data pop-up window, click the “Exit” button.

3.3.4.5 NSM Session Boundary Overlay - Options

Clicking the "Options" button within the "Session Overlap Boundary" section of the NSM "Synthetic Admin Info" control window produces the “Color Overlay Options” pop-up window illustrated in Figure 32. The “Colors Overlay Options” pop-up window contains a “Colors” pulldown menu which offers a choice among six colors. When one of the six colors is selected, it will appear in the textbox to the right of the pulldown menu header. To close the “Color Overlay Options” pop-up window, click the “Ok” button. To restore the color selection to its default value, click the “Reset” button.

Figure 32. The NSM “Color Overlay Options” pop-up window.
3.3.4.6 NSM Repeat - Repeat

Clicking the "Repeat" button within the "Repeat" section of the NSM "Synthetic Admin Info" control window produces the "Repeat Sessions" pop-up window, which is similar to Figure 31. The "Repeat Sessions" pop-up window allows retrieval of information from a Closed session, but only as a duplicate. It does not open the Closed session for modification. Closed sessions are indicated by the existence of an ending date. To select a session, click the text line containing information about the desired session to highlight it. Once the desired session is highlighted, click the "Ok" button to retrieve the session from the database as a duplicate. To close the "Repeat Sessions" pop-up window, click the "Exit" button.

3.3.4.7 NSM Terminate - Close

Closing (terminating) a session places an ending date on the session and ensures that nothing else can be added to that session. For instance, once a session has been closed the user is no longer allowed to add provinces or profiles to the session. If a session has been closed, it is inaccessible from the Unclosed session selection window; it must be accessed via the Repeat button. Once a session is closed, it remains in the Unclosed window but with its ending date specified, thereby indicating that it has been closed.

3.3.4.8 NSM Terminate - Turnoff

Turning Off (terminating) a session suspends addition of provinces and associated profiles to current New or Unclosed session. Once a session has been turned off, it must be re-selected as an "Unclosed" session in order to make further additions.

3.3.4.9 NSM Terminate - Reset

The "Reset" Button sets all flags to their default values. New or Unclosed sessions are turned off. All selected sessions are deactivated.
4 ERROR MESSAGES:

When NIDAS is executed, receiving the message "SQL message - 106" means that the database is locked. Ask the NIDAS DBA to unlock the database via the command "msclearlock" <path to the database>. Note: Executing "msclearlock" will close the database for all current users, requiring each user to reopen the database.

When NIDAS is executed, receiving the message "Cannot read default values" means that NIDAS is being executed from the wrong directory. Try to find the directory where Nidas_Config.def file is located. Move ("cd") to that directory and try to launch NIDAS from there.

When the message "UNIRAS aborted" or if the application quits without any message, call user support at (601) 688-7141 or (601) 688-2960.
5 NOTES:

5.1 Glossary

See the glossary contained in Appendix A for definitions of key terms used in this document. Also, see definitions given in Section 1.3.3.

5.2 Abbreviations (acronyms)

See the listing of acronyms in Appendix B for definitions of all acronyms.

5.3 System Considerations

NIDAS is intended for installation in and execution by Sun Microsystems, Incorporated computing platforms. Installation is site specific and tailorable to the environment. Appendix E provides information specific to installation of NIDAS within the NAVOCEANO computing environment. NIDAS may be executed from an X-terminal; however, some graphical screens produced by NIDAS are memory intensive and will cause termination of the software if X-terminal memory is insufficient.

5.3.1 System/Software Requirements

NIDAS is an integrated software system that requires the presence of both specific commercial off-the-shelf software and government-provided software. While the details of integrated software item requirements are provided in Appendix D, the following general comments apply:

1) NIDAS was designed for execution under control of the UNIX operating system on Sun Microsystems hardware.

2) NIDAS requires the presence of the X-Windows client-server environment.

3) The Open Software Foundation’s (OSF) Motif Toolkit (library) must be present and available in the execution environment.

4) A runtime version of UNIRAS ag/X Toolmaster software must be installed on the system and available in the execution environment to support NIDAS graphical display options.

5) The Empress relational database engine must be installed on the system and available for execution as the vehicle for accessing data contained in the NIDAS database.

6) The Naval Environmental Operational Nowcast System (NEONS) must be installed as the functional database model and library of database access tools.

7) Of interest to programmers, the software code for this version of the NIDAS as compiled using C and Fortran compilers supplied by Sun Microsystems, Incorporated.

8) NIDAS is an interactive application. It supports all standard X-Windows mouse and keyboard functions. See Section 2 for references that explain X-Window procedures and terminology in greater detail.
5.3.2 Directory Map

NIDAS software executables have been designed to execute using directory paths defined via UNIX environmental parameters and pathnames defined within user ".login" or ".cshrc" files. These parameters must be determined during installation since they are system dependent.

5.3.3 Security

NIDAS neither supports nor restricts the overall classification of the computing environment; however, classification codes are contained in the header information of each profile. The NDBA controls access to NIDAS data by authorizing levels of access based on the clearances held by individual users.

5.3.4 Installation Procedures

Appendix E describes procedures for installing NIDAS as an executable application within the NAVOCEANO computing environment.
APPENDIX A
Glossary of Terms

bathymetric - of or pertaining to the depth of the ocean.

**Computer Software Configuration Item (CSCI)** - a software application or a major component thereof.

**Computer Software Component (CSC)** - a top level functional module within a computer software configuration item (CSCI). CSC’s are generally considered to be one structural level below the CSCI.

**Data Interactive Module (DIM)** - NIDAS module that performs data manipulation functions and processing required for display and interpretation of data.

**Data Retrieval Module (DRM)** - NIDAS module responsible for identifying, obtaining and formatting data obtained from the NIDAS (NEONS) database.

**Graphical User Interface (GUI)** - NIDAS module responsible for interfacing with the user and controlling the functionality of the main NIDAS display.

**Julian** - The day of the year according to the Julian calendar which begins on January 1. A Julian date does not include a year as part of its simple format.

**metadata** - Information about a dataset, either descriptive or definitive as to quantity, quality, quantity or format.

**NIDAS Session Module (NSM)** - NIDAS module for management of province and profile construction.

**profile** - A sequential listing of parameters keyed to a reference structure. A bathymetric profile contains sequential depth/parameter groups.

**Widget** - "...a graphic device capable of receiving input from the keyboard and the mouse and communicating with an application or another widget by means of a callback. Every widget is a member of only one class and always has a window associated with it." (from: OSF/Motif Programmer’s Guide, Rev. 1.1, Open Software Foundation, Prentice Hall, Englewood Cliffs, NJ, 1991, p. GL-13.)

**zoom** - The graphical scaling process whereby a screen display item is enlarged or reduced in size.
APPENDIX B
List of Acronyms

CAST - Center for Air Sea Technology
CLIMO - climatology
CSC - Computer Software Component
CSCI - computer software configuration item
DBDR - Database Design Requirement
DBFR - Database Functional Requirement
DOD - Department of Defense
DIM - Data Interactive Module
DRM - Data Retrieval Module
GDEM - General Digital Environmental Model
GOODS - Global Oceanographic Observation Data Set
GUI - Graphical User Interface
lat - latitude
lon - longitude
MODAS - Modular Ocean Data Assimilation System
MOODS - Master Oceanographic Observation Data Set
MSU - Mississippi State University
NASA - National Aeronautics and Space Administration
NAVOCEANO - Naval Oceanographic Office
NDBA - NIDAS Database Administrator
NDMS - NIDAS Data Management System
NEONS - Navy Environmental Operational Nowcast System
NDR - NIDAS Data Requirement
NFR - NIDAS Functional Requirement
NIDAS - Naval Interactive Data Analysis System
NSM - NIDAS Session Module
OTIS - Optimal Thermal Interpolation System
OSF - Open Software Foundation
RDBMS - Relational Database Management System
sal - salinity
snd speed - sound speed
SQL - Structured Query Language
temp - temperature
APPENDIX C

User Default File

Default values for parameters that are critical to NIDAS operation are maintained in a user default file. Users should not create their own user default file. Instead, the file should be provided by NIDAS site managers. Site managers should ensure that file privileges are restricted to "read only". Any changes to this file could cause the application to fail for the user. All values and colors may be changed through interaction with NIDAS, except minlat, maxlat, minlon, and maxlon, all of which are "hard-wired" in the current version. When launching NIDAS, the application will look for the file "nidas_config.def" in the current directory. If the "nidas_config.def" file cannot be located, the application will fail. The format for the "nidas_config.def" default file is as follows:

```
22.0 31.0 47.0 74.0 /* min and max latitude and longitude */
3.0 1.0 /* longitude and latitude axis ticks */
wvs_8km_cst /* resolution of coastline */
WHITE /* color of the coastline */
ORANGE 100.0 /* Bathymetry color and contour interval */
10.0 35.0 0.0 400.0 /* min and max temperature and depth */
Temp /* x axis label */
Depth /* y axis label */
3 /* number of parameters */
temp /* temperature */
sal /* salinity */
sndspd /* sound speed */
YELLOW /* color of MODAS contour */
center_date 30 /* Center date for MOODS data */
GREEN 15 /* Day 1 time color and window */
GREEN 0 /* Day 2 time color and window */
GREEN 0 /* Day 3 time color and window */
sst_color BLUE /* Sea surface temperature color */
polygon1_color ORANGE /* day 1 polygon color */
polygon2_color YELLOW /* day 2 polygon color */
polygon3_color WHITE /* day 3 polygon color */
classification 10001000 10001000 /* min and max classification for MOODS */
source_code 2 31 /* min and max source code for MOODS */
inst_type 0 33 /* min and max instrument type for MOODS */
months 1 2 /* min and max months for MOODS */
cruise 0 15175 /* min and max cruise number for MOODS */
parm 3 3 /* min and max parameters for MOODS */
water_depth 0 3958 /* min and max water depth for MOODS */
level 0.0 /* MODAS level to be plotted */
epoch/cast/dharmesh/cast/backup/src/otis_data.out /* MODAS output file */
epoch/cast/dharmesh/cast/backup/src/gdem_data.out /* Climatology output file */
epoch/cast/dharmesh/cast/backup/src/moods_data.out/* MOODS output file */
epoch/cast/dharmesh/cast/backup/src/goods_data.out/* GOODS output file */
epoch/cast/dharmesh/cast/backup/src/vol_data.out/* NIDAS output file */
```
APPENDIX D
Commercial and Noncommercial Software

NIDAS has been developed to operate within a Sun Microsystems SparcStation model 10 computer hardware environment. The operating system is SUNOS version 4.1.3, including the resident SUN C compiler which was used to write the NIDAS software code. Some minor elements of NEONS have been written in FORTRAN77 (Sun FORTRAN77 version 1.4). Graphics support is provided by UNIRAS ag/X Toolmaster version 6v3b. The RDBMS engine is Empress version 6.2. The windowing environment consists of X-Windows version X11 R5 and the OSF Motif widget set version 1.3.
APPENDIX E

NIDAS Installation Procedures

The following instructions for installation are also provided on the NIDAS installation tape in the file "README":

Instructions for:
1) Setting up the user .cshrc file.
2) Installing the NIDAS Database files.
3) Installing the NEONS software tree.
4) Installing the NIDAS images.
5) Installing the NIDAS user application resource files.
6) Installing the NIDAS user application software.

Files provided:
README - This instruction file for setting up a NIDAS environment.
cshrc - An example user .cshrc file.
db.tar - Tar file of the NIDAS database files.
isdb.tar - Tar file of the NEONS software.
Install - The Install script that makes and installs the NEONS software libraries and shells and executables.
image.tar - Tar file of the NIDAS images.
app-defaults.tar - Tar file of the NIDAS user application resource files.
nidas.tar - Tar file of the NIDAS user application software.

SETUP ENVIRONMENT:
* Set up a login account as 'nidasdba'.
* Login as the nidasdba and execute umask 022.
* Identify the directory path for Empress version 6.x (installed).
* Identify the directory path for UNIRAS ag/X Toolmaster (installed).
* Modified or overwrite the .cshrc with the cshrc file provided on tape.
* Set the MSPATH environment variable within the .cshrc file to point to the location of Empress.

For example, suppose Empress was installed in /usr/empress:
change setenv MSPATH /usr/empress/v6.2
to setenv MSPATH /usr/empress/v6.2

add $MSPATH/bin to path
set path = ($path $MSPATH/bin)
* Set the UNIRAS environment variable within the .cshrc to point to the location of UNIRAS ag/X Toolmaster.

For example, suppose ag/X Toolmaster is installed in the /appl directory:

```
change setenv UNIRAS ?/uniras
  to setenv UNIRAS /appl/uniras
```

```
add setenv UNIDIR $UNIRAS
```

* Create a database directory which will contain the NIDAS database. Move the db.tar file to that directory. Extract the NIDAS database files from the db.tar file.

For example, suppose you wish to create a NIDAS database within the existing directory path /nidas. Execute the following commands.

```
mkdir /nidas/db
mv db.tar /nidas/db/db.tar
change (cd) to the /nidas/db directory
 tar xvf db.tar
```

Set the environment variable NEONS_DB within the .cshrc to point to this directory.

```
change setenv NEONS_DB ?/neons_db
  to setenv NEONS_DB /nidas/db
```

* Create a directory to hold the NEONS software. Move the isdb.tar file to that directory. Extract the NEONS software tree from the isdb.tar file.

For example, suppose you wish to create a NEONS software directory within the existing directory path /nidas. Execute the following commands:

```
mkdir /nidas/isdb
mv isdb.tar /nidas/isdb/isdb.tar
change (cd) to the /nidas/isdb directory
 tar xvf isdb.tar
```

Set the environment variable NEONS_SW within the .cshrc to point to this directory.

```
change setenv NEONS_SW ?/isdb
  to setenv NEONS_SW /nidas/isdb
```

add $NEONS_SW/bin to path
  set path = ($path $NEONS_SW/bin)

* Source the modified .cshrc file to update the nidasdba environment. Run the Install script to make and install the NEONS libraries, shells and executables.

```
source ~/nidasdba/.cshrc
Install
```

E-2
* Create an image directory for storage of NIDAS images. Move the image.tar file to that directory and extract the NIDAS images from the image.tar file.

For example, suppose you wish to create an image database directory under the existing directory /nidas. Execute the following commands:

```
mkdir /nidas/image.db
mv image.tar /nidas/image-db/image.tar
change (cd) to the /nidas/image-db directory
tar xvf isdb.tar
```

Then, update the NIDAS database table 'as_im' to contain the correct path name for each image loaded.

```
empsqlcmd $NEONS_DB "update as_im set path_name = '/nidas/image_db'"
```

Then, update the NIDAS database table 'im_path' to contain the image directories (im_path) used.

```
empsqlcmd $NEONS_DB "update im_path set pathname = '/nidas/image_db'"
```

* Run test examples under $NEONS_SW/src/*_ex to check connectivity between the NIDAS database and the NEONS library software routines. (optional)

* Create an 'app-defaults' directory. Move the app-defaults.tar file to that directory. Extract the NIDAS application resource files from the app-defaults.tar file.

For example, suppose you wish to create an app-defaults directory under the nidasdba home directory: Execute the following commands:

```
mkdir /nidasdba/app-defaults
mv app-defaults.tar /nidasdba/app-defaults
change (cd) to the /nidasdba/app-defaults directory
tar xvf app-defaults.tar
```

Then, set the environment variable XAPPLRESDIR within the .cshrc to point to this directory.

```
change setenv XAPPLRESDIR */app-defaults
to setenv XAPPLRESDIR -nidasdba/app-defaults
```

* Create a NIDAS application directory. Move the nidas.tar file to that directory. Extract the Nidas application software tree from the nidas.tar file.

For example, suppose you wish to create a NIDAS application directory under /appl:
mkdir /appl/nidas
mv nidas..ar /appl/nidas/nidas.tar
change (cd) to the /appl/nidas directory
tar xvf nidas.tar

Then, make an executable of the NIDAS application.

move (cd) to the /appl/nidas/src directory and execute the command make.

Then, update the nidasdba .cshrc file to include the path to the NIDAS executable.

add /appl/nidas/src to the path
set path = ($path /appl/nidas/src)

* Source the modified .cshrc file to update the nidasdba environment.

source ~nidasdba/.cshrc

NIDAS INSTALLATION AND ENVIRONMENT SETUP SHOULD NOW BE COMPLETED - If all went well!
SOFTWARE USER'S MANUAL FOR THE NAVAL INTERACTIVE DATA ANALYSIS SYSTEM (NIDAS)

DHARMESH KRISHNAMAGARU LEANA DUSANG VISHNUMOHAN DAS M.S. FOSTER

MISSISSIPPI STATE UNIVERSITY CENTER FOR AIR SEA TECHNOLOGY BUILDING 1103, ROOM 233 STENNIS SPACE CENTER, MS 39529-6000

RESEARCH PERFORMED VIA MISSISSIPPI RESEARCH CONSORTIUM UNDER NASA PROCUREMENT OFFICE CONTRACT NAS13-564, DELIVERY ORDER #11.

APPROVED FOR PUBLIC RELEASE; DISTRIBUTION IS UNLIMITED.

THE NAVAL INTERACTIVE DATA ANALYSIS SYSTEM (NIDAS) VERSION 1.0 HAS BEEN DEVELOPED TO PROVIDE INTERACTIVE BLENDING AND OVERLAY CAPABILITIES FOR A BROAD RANGE OF ENVIRONMENTAL DATA TYPES AND FORMATS. THIS MANUAL DESCRIBES NIDAS SOFTWARE CAPABILITIES AND PROVES INSTRUCTIONS FOR ITS USE.
Distribution List

1. Oceanographer of the Navy
   U.S. Naval Observatory
   34th & Massachusetts Avenue
   Washington, DC 20392

2. Commanding Officer, Code DOST
   Naval Oceanographic Office
   Stennis Space Center, MS 39529
   (6 copies)

3. Technical Director
   Code OOT
   COMNAVMETOCOM
   Stennis Space Center, MS 39529

4. Defense Technical Information Center
   Building 5, Cameron Station
   Alexandria, VA 22304-6145
   (2 copies)

5. Director, Centers and Institutes
   Mississippi State University
   Mississippi State, MS 39762

6. Office of Naval Research
   Code 1242
   800 N. Quincy Street
   Arlington, VA 22217-5000

7. Technical Director
   Naval Research Laboratory
   Stennis Space Center, MS 39529

8. Naval Research Laboratory
   Code 7320
   Stennis Space Center, MS, 39529

9. Naval Research Laboratory
   Code 3250
   Stennis Space Center, MS 39529

10. Commanding Officer
    Fleet Numerical Meteorology and
    Oceanography Center
    Monterey, CA 93943-5000

11. University of Southern Mississippi
    Center for Ocean and Atmospheric
    Modeling
    Stennis Space Center, MS 39529

12. Technical Director
    Naval Research Laboratory
    Monterey, CA 93943-5000

13. Commanding Officer
    Naval Research Laboratory
    4555 Overlook Avenue
    Washington, DC 20350

14. Space and Naval Warfare
    Systems Command (PMW 141)
    Washington, DC 20363